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U.S. CONTACT INFORMATION

9023 Columbine Road
Eden Prairie, MN 55347
Toll Free: 800-872-2599
Phone: 952-937-5161

Web: http://www.ontrackpowercontrols.com

Software Sales
Toll Free: (800) 645-3649
Email: software@ontrackpowercontrols.com

Technical Support
Phone: 952-937-2121
Email: support@ontrackpowercontrols.com
Web: http://www.ontrackpowercontrols.com/support
Hours: 8:00 a.m. - 5:00 p.m., M-F CST
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INTERNATIONAL CONTACT INFORMATION

Canada Australia
155 Gordon Baker Road Suite 210
Toronto, Ontario M2H 3N7
Canada

Web: http://www.ontrackpowercontrols.ca

28 Donkin Street, Suite #8
West End, QLD 4101
Australia

Web: http://www.ontrackpowercontrols.com.au

Software Sales
Toll Free: 800-645-3649
Email: software@ontrackpowercontrols.ca

Software Sales
Freephone: 1800 872 259
Email: software@ontrackpowercontrols.com.au

Technical Support
Phone: 952-937-2121
Email: support@ontrackpowercontrols.ca
Web: 
http://www.ontrackpowercontrols.ca/support

Technical Support
Phone: +61 7 3255 1199
Email: support@ontrackpowercontrols.com.au
Web: 
http://www.ontrackpowercontrols.com.au/support

United Kingdom France
The Pavilions, 1 Weston Road
Kiln Lane, Epsom
Surrey KT17 1JG
United Kingdom

Web: http://www.ontrackpowercontrols.co.uk

2, impasse de la Noisette
91371 Verrières-le-Buisson Cedex 413
France

Web: http://www.ontrackpowercontrols.fr

Software Sales
Tel: +44 (0)1372 741 999
Email: software@ontrackpowercontrols.co.uk

Support Commercial
Tél: +33 (0)1 69 53 66 92
Email: logiciel@ontrackpowercontrols.fr

Technical Support
Tel: +44 (0)1372 744 422
Email: support@ontrackpowercontrols.co.uk
Web: 
http://www.ontrackpowercontrols.co.uk/support

Support Technique
Tél: 0820 09 87 72
Email: support@ontrackpowercontrols.fr
Web: 
http://www.ontrackpowercontrols.fr/support

Germany Spain
Hanns-Klemm-Straße 5
71034 Böblingen
Deutschland

Web: http://www.ontrackpowercontrols.de

Primera Planta, Oficina B
C. Anabel Segura 7
28108 Alcobendas
Madrid
España

 Web: http://www.ontrackpowercontrols.es
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Software Sales
Tel: +49 (0)7031/644-0
Email: software@ontrackpowercontrols.de

Venta de Licencias
Tel: 900 112 012
Email: software@ontrackpowercontrols.es

Technical Support (available in German 
and English)
Tel: +49 (0)7031/644-244
Email: support@ontrackpowercontrols.de
Web: 
http://www.ontrackpowercontrols.de/support

Soporte técnico
Tel: 900 112 212
Email: soporte@ontrackpowercontrols.es
Web: 
http://www.ontrackpowercontrols.es/soporte

Norway* Italy

Postboks 1250
Arkoveien 14
2206 Kongsvinger
Norge

Web: http://www.ontrackpowercontrols.no

Via Lario, 1
I - 22070 Fenegró (CO)
Italia

Web: http:// www.ontrackpowercontrols.it

Software Sales

Software Sales
Toll-free: 810 10 100
Phone: +47 62 81 01 00
Fax: +47 62 81 01 10
Email: software@ontrackpowercontrols.no

Numero Verde: 800 44 00 33
Tel: +39 02 96943211
Fax: +39 02 96943221
Email: software@ontrackpowercontrols.it

Technical Support (available in English)

Technical Support
Phone: +47 62 81 01 00
Email: support@ontrackpowercontrols.no
Web: http://www.ontrackpowercontrols.no

Tel: +49 7031/644-244
Email: support@ontrackpowercontrols.it
Web: http://www.ontrackpowercontrols.it/support

Sweden* Denmark*
Drottninggatan 7
753 10 Uppsala
Sverige

Web: http://www.ontrackpowercontrols.se

H. P. Christensensvej 1
3000 Helsingør
Danmark

Web: http://www.ontrackpowercontrols.dk

Software Sales
Tel: +46 (0)18 10 44 40
Fax: +46 (0)18 10 99 20
Email: support@ontrackpowercontrols.se

Software Sales
Tel: +45 70 22 34 00
Fax: +45 70 22 34 01
Email: software@ontrackpowercontrols.dk
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* These locations are currently operating under the Ibas brand, which was acquired by Kroll Inc in 
2006.

Technical Support
Phone: +47 62 81 01 00
Email: support@ontrackpowercontrols.se
Web: http://www.ontrackpowercontrols.se

Technical Support
Phone: +47 62 81 01 00
Email: support@ontrackpowercontrols.dk
Web: http://www.ontrackpowercontrols.dk

Finland* Singapore
Norman Ibas Oy
Läkkisepäntie 11
00620 Helsinki
Finland

Web: http://www.ontrackpowercontrols.fi

Nordic European Centre
3, International Business Park
#02-17
Singapore 609927

Web: 
http://www.ontrackdatarecovery.com.sg/email-
recovery-software

Software Sales
Tel: +358 9 2727 210
Fax: +358 9 2727 2121
Email: software@ontrackpowercontrols.fi

Software Sales
Phone: +65 6296 5131
Email: software@ontrackpowercontrols.com

Technical Sales
Tel: +358 9 2727 210
Email: support@ontrackpowercontrols.fi
Web: http://www.ontrackpowercontrols.fi

Technical Support
Phone: +1 952-937-2121
Email: support@ontrackpowercontrols.com

Web: 
http://www.ontrackdatarecovery.com.sg/software-
support/
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INTRODUCTION

INTRODUCTION

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Overview

Welcome to Ontrack® PowerControls™ 6.0, the software that allows you to perform source and 
target functions on Microsoft® Office SharePoint® Server 2007 data, including opening, copying, 
exporting, restoring, and saving attachments. It also provides a robust search function on source 
items.

Ontrack PowerControls for SharePoint works with your existing SharePoint database, and allows 
you to restore content from MDF files, NDF files, and LDF files directly to your SharePoint target, 
or to a different SharePoint server. 

The Ontrack® PowerControls™ ExtractWizard supports extracting SQL data from online 
Microsoft® SQL Server® 2005 or Microsoft® SQL Server® 2008 backups created with Enterprise 
Manager or SharePoint tools and Site Administrator. SharePoint backups can be extracted from 
tape or disk-based backups using the Direct method of extraction. See Ontrack PowerControls 
ExtractWizard User Guide for more information.

This user guide provides step-by-step instructions for completing specific tasks on the Microsoft® 
Windows®-based platform. See the Table of Contents or the Index to locate the pages on which 
particular topics are discussed.

Use Adobe® Acrobat® to open the PDF version of this user guide. After you open the PDF file, 
click the Hand tool to view the Table of Contents hyperlinks in layout view. Then click a hyperlink 
to jump to a specific topic in the manual.

Five Major Reasons for Using Ontrack PowerControls for 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Microsoft Office SharePoint Server 2007

There are five primary ways you can benefit from using Ontrack PowerControls for SharePoint:

Minimizes the time to restore an individual document, item, list, folder, site, or library. 
Ontrack PowerControls for SharePoint can slash restore time, making it possible to granularly 
restore items from a previous full backup. Items from database backup can be restored individually, 
giving you restore flexibility and eliminating the need to perform to a full site restoration in order to 
find the items you need.

Eliminates same site restore constraint. By eliminating same site restore constraint, Ontrack 
PowerControls gives you the flexibility to restore to origination or alternate SharePoint locations. 
Ontrack PowerControls allows you to restore directly into your production SharePoint server, or 
directly into a file system. 

Minimizes the time to locate all matching specific criteria. Ontrack PowerControls includes an 
Advanced Find feature that can search across all content databases in an archive SharePoint file, 
rather than bringing an old backup back online for analysis. You can search by a variety of criteria, 
including keywords, subject, date, specific users, and file and attachment data.
Copyright © 2010 Kroll Ontrack Inc. 1



I N T R O D U C T I O N
Ontrack PowerControls 6.0 for SharePoint EnhancementsINTRODUCTION
Maintains data integrity of the SharePoint source. Ontrack PowerControls does not change the 
contents or metadata of the SharePoint source, and maintains data integrity of the SharePoint 
source by performing read-only operation.

Minimizes the costs involved in restoring lost items. Ontrack PowerControls for SharePoint 
eliminates the need to have an expensive restoration server available as well as the cost associated 
with the extra steps required to separately import sites back into SharePoint to find items needed. 
Also, since it can read your existing content database backups, there is no need to purchase 
proprietary software for creating the backups. Your backup process can remain the way it is today.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Ontrack PowerControls 6.0 for SharePoint Enhancements

Ontrack PowerControls 6.0 for SharePoint contains all the features and benefits of Ontrack 
PowerControls 5.2 for SharePoint plus these exciting new and improved features: 

• Support for Windows® Server 2008 R2
• Support for VMware® ESX 4.0
• Support for Microsoft® Hyper-V Server™ 2008 R2
• Windows® 7 Professional, Enterprise, Ultimate

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
System Requirements

To use Ontrack PowerControls for SharePoint on your computer, you need the following hardware 
and software: 

• One of the following operating systems:
• Windows® XP Professional
• Windows Server® 2003 
• Windows Server® 2008 Standard
• Windows Server 2008 Data Center
• Windows Server 2008 Enterprise
• Windows Server 2008 R2
• Windows Vista® Business
• Windows Vista Ultimate
• Windows Vista Enterprise
• Windows 7 Professional
• Windows 7 Enterprise
• Windows 7 Ultimate
2 Copyright © 2010 Kroll Ontrack Inc.
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. .I N T R O D U C T I O N
Installing Ontrack PowerControls
Note:  The operating systems listed above are required to have the latest service packs 
installed.

Note:  32-bit and 64-bit versions of the above operating systems are supported.

Note:  The HASP HL override key functionality does not work on Windows Vista, Windows 
Server 2008, Windows Server 2008 R2, and Windows 7 operating systems when using a 
remote desktop connection to the computer.

• The following virtual environments are supported:
• VMware® Server 1.0x, 2.x
• VMware® Workstation v6.0x for Windows 
• Microsoft® Virtual Server 2005 R2
• Microsoft® Hyper-V™
• Microsoft® Hyper-V Server™ 2008 R2
• Microsoft® Virtual PC 2007
• VMware® ESX 4.0, ESXi

Note:  Virtual operation of tape devices may have restrictions imposed by virtual operating 
systems.

Note:  HASP key operation is validated in environments that support USB attached devices 
and support the Kroll Ontrack-distributed HASP drivers only.

• Microsoft® Office SharePoint® Server 2007, Microsoft® Office SharePoint® Server 2007 
SP1, and Microsoft® Office SharePoint® Server 2007 SP2

• Microsoft® Office SharePoint® Server 2007 SP1, and Microsoft® Office SharePoint® 
Server 2007 SP2 data stored on Microsoft® SQL Server® 2005, Microsoft® SQL Server® 
2005 SP2, Microsoft® SQL Server® 2005 SP3, Microsoft® SQL Server® 2008, and 
Microsoft® SQL Server® 2008 SP1

• Microsoft® .NET Framework 3.5
• Intel® Pentium® compatible processor 
• 1024 MB RAM minimum
• 200 MB of free hard disk space for the installation. More disk space will be needed for 

processing log files when opening an MDF file.
• Monitor with 800 x 600 or higher screen resolution
• USB port (for Ontrack PowerControls product licenses requiring HASP key dongle to run 

application)

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Installing Ontrack PowerControls

Follow these steps to install Ontrack PowerControls for SharePoint:

1. Turn off any disk utility or antivirus program running in the background.
2. Insert the Ontrack PowerControls CD-ROM into your CD-ROM drive.
Copyright © 2010 Kroll Ontrack Inc. 3



I N T R O D U C T I O N
Uninstalling Ontrack PowerControlsINTRODUCTION
3. The installation program automatically starts. If it does not: 
• For Microsoft Vista, Windows Server 2008, and later: Click Run on the Start/All 

Programs/Accessories menu, and type D:\autorun.exe or D:\bin\setup.exe, where D 
is the drive letter of your CD-ROM drive. Click OK.

• For Windows Server 2003 and earlier: Click Run on the Start menu, and type 
D:\autorun.exe or D:\bin\setup.exe, where D is the drive letter of your CD-ROM 
drive. Click OK.

4. Follow the on-screen instructions.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Uninstalling Ontrack PowerControls

You can uninstall Ontrack PowerControls for SharePoint by running the uninstall program.

1. Click Start and then click Control Panel.
2. In the Control Panel:

For Microsoft Vista, Windows Server 2008, and later: Click Uninstall a program under 
the Programs heading.

• Click Ontrack PowerControls 6.0, and then click Uninstall/Change.
For Windows Server 2003 and earlier: Click the Add or Remove Programs icon.

• Click Ontrack PowerControls 6.0, and then click Change/Remove.
• Click Yes when the confirmation dialog box appears.

3. Follow the on-screen instructions.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Keyboard Shortcuts

Menu Bar Keyboard Shortcut

File Menu

Open Source Ctrl+S

Open Target Ctrl+T

Open Item Ctrl+O

Close Store Ctrl+L

Use Wizard Ctrl+W

Exit Alt+F4

Edit Menu
4 Copyright © 2010 Kroll Ontrack Inc.
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Keyboard Shortcuts
Copy Ctrl+C

Paste Ctrl+V

Select All Ctrl+A

View Menu

Refresh Screen F5

Tools Menu

Export Ctrl+P

Find F3

Help Menu

View Help Contents F1

Menu Bar Keyboard Shortcut
Copyright © 2010 Kroll Ontrack Inc. 5



I N T R O D U C T I O N
Ontrack PowerControls LicensingINTRODUCTION
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Ontrack PowerControls Licensing

Ontrack PowerControls software editions are licensed based on the number of configured 
SharePoint databases in your environment. The license is used for a customized number of 
databases for a specified period of time.

Ontrack PowerControls also offers a free edition with limited functionality. With this edition, you 
can search a SharePoint database as a source, and view items.

Technical Note: Ontrack PowerControls for SharePoint does not open more databases than 
originally licensed for.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Enabling the Licensed Agents

Each edition of Ontrack PowerControls software for SharePoint is distributed with two Ontrack 
PowerControls ExtractWizard Agents and one Ontrack PowerControls Agent for SharePoint. All 
other Agents are shipped with all Ontrack PowerControls editions in disabled conditions and 
require a new license file to be enabled. 

Ontrack 
PowerControls 

Edition

Ontrack 
PowerControls 

Feature
Agents Feature

Ontrack 
PowerControls 6.0 

Subscription 
enforcement

For Direct Method: ExtractWizard Agent 
included and partially enabled.

For Advanced Method: ExtractWizard Agent 
is not included and is disabled.

Agent for Advanced Searching for SharePoint 
(priced separately)

Agent for Native SharePoint Backups

Ontrack 
PowerControls 6.0 
Free

All features included 
and partially enabled 
(open any MDF file, 
view all content, 
search one source, 
copy none)

For Direct Method: ExtractWizard Agent 
included and partially enabled.

For Advanced Method: ExtractWizard Agent 
is not included and is disabled.

Ontrack 
PowerControls 

ExtractWizard Agent
Versions 

Supported Disk Backup Tape Backup

Agent for Native 
SharePoint Backups

STSADM and Site 
Administrator

.BAK Files Microsoft Tape 
Format (MTF)
6 Copyright © 2010 Kroll Ontrack Inc.
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. .I N T R O D U C T I O N
Upgrading Ontrack PowerControls
Note:  The Agent for Native SharePoint Backups does not support transaction log backups or 
differential backups.

In addition to Ontrack PowerControls ExtractWizard Agents, Ontrack PowerControls users also 
have the option to purchase other unique add-on features for enhanced search and analysis 
capabilities for SharePoint.

To view the currently enabled Agents 

• On the Help menu, click About and then click License Info.

To enable an Agent 

1. Contact a sales representative and specify which agent you wish to purchase. A license file 
containing the newly enabled agent will be sent to you. 

Note:  To contact a sales representative, see U.S. Contact Information.

2. Replace the existing .ini file with the new .ini file. The default location for this file is in the 
Ontrack PowerControls directory. 

The License File

All Ontrack PowerControls editions for SharePoint require a license file. The purpose of this file is 
to let you buy only those features you need. Before Ontrack PowerControls for SharePoint is 
enabled, it checks the .ini file for four things:

• The license file must be valid for Ontrack PowerControls 6.0. 
• Database enforcement, if applicable. 
• Subscription length, if applicable.
• Enabled Agents (Ontrack PowerControls ExtractWizard Agents and Ontrack 

PowerControls Agents for SharePoint)

Note:  To view and/or change the location of the license file, see “Setting Preferences” on page 23. 
In the Preferences window, see the instructions for the “License file name” preference.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Upgrading Ontrack PowerControls

If Ontrack PowerControls 5.2 has been previously installed, is active, and you are upgrading to 
Ontrack PowerControls 6.0, you will not be able to reuse the existing Ontrack PowerControls 5.2 
license file with Ontrack PowerControls 6.0. 

Ontrack PowerControls Agent

Agent for Advanced Searching for SharePoint
Copyright © 2010 Kroll Ontrack Inc. 7



I N T R O D U C T I O N
Getting HelpINTRODUCTION
Upgrading Ontrack PowerControls when Kroll Ontrack Administrative Server is Required

If the Kroll Ontrack Administrative Server (KOAS) is required either through the use of the Agent 
for Administrative Services or for the Central Licensing Service (CLS), before upgrading Ontrack 
PowerControls, it is necessary to first upgrade your KOAS 1.2 server and optionally configure CLS 
to use your new Ontrack PowerControls 6.0 CLS license. Please see the KOAS user documentation 
for details on how to perform an upgrade installation. 

To upgrade site installations requiring KOAS when CLS is in use

1. Close down all Ontrack PowerControls clients.
2. Upgrade KOAS 1.2 to KOAS 6.0.
3. Start the KOAS management console to verify KOAS has upgraded.
4. Using the KOAS CLS plug-in, in the License File tab, configure KOAS 6.0 CLS to use the 

Ontrack PowerControls 6.0 CLS license file provided with the delivery of Ontrack 
PowerControls 6.0 and KOAS 6.0.

5. Follow the instructions and restart KOAS to ensure that CLS is running properly. If the 
wrong CLS license file is configured, an error displays in the CLS status displays.

6. Use existing Ontrack PowerControls 5.2 installation.

Note:  Ontrack PowerControls 5.2 installations can be upgraded to Ontrack PowerControls 
6.0 as required.

To upgrade site installations requiring KOAS when CLS is not in use

1. Close down all Ontrack PowerControls clients.
2. Upgrade KOAS 1.2 to KOAS 6.0.
3. Start the KOAS management console to verify KOAS has upgraded.
4. Use existing Ontrack PowerControls 5.2 installation.

Note:  Ontrack PowerControls 5.2 installations can be upgraded to Ontrack PowerControls 
6.0 as required.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Getting Help

Kroll Ontrack provides you with the following ways to get help with Ontrack PowerControls: 
“Online Help” and “Technical Support”.

Online Help

Online Help includes all of the information in the user guide and more, and lets you quickly access 
this information by using one of three tabs. The Contents tab offers a hierarchical view of the 
contents of the user guide. The Search tab offers a full-text search of the user guide. The Index tab 
offers a keyword-based way to get to specific topics.

To start online Help

Do one of the following:

• On the Help menu, click Contents.
8 Copyright © 2010 Kroll Ontrack Inc.



. .
 . 

. .I N T R O D U C T I O N
Conventions in this Manual
• Click  on the toolbar.
• Press the F1 key.

To identify a tool or control

• Position the pointer over a tool or control, and then pause. A tool tip shows the name of the 
item.

Technical Support

If you have questions or problems not answered in the user guide or the online Help (F1), call our 
Technical Support group. When reporting an issue, please include any information that might help 
us diagnose the problem. The following details are often the most helpful:

• The version of Ontrack PowerControls you are using (on the Help menu, click About).
• The versions of Windows operating systems that you are running.
• The version of SQL Server that contained the source database file.
• The circumstances and sequence of steps that led to the problem.
• The text of the error messages (if any appeared), and the contents of the Details window.
• A list of other Windows-based programs that you were running when the error occurred.

See “U.S. Contact Information” and “International Contact Information” at the beginning of this 
user guide.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Conventions in this Manual

This manual uses guidelines for commands available on shortcut menu and notes and tips. 

Shortcut Menu

You can access many of the same commands available on the menu bar and toolbar by right-
clicking the mouse to display a shortcut menu. The contents of the shortcut menu depend on 
whether you right-click in the source or target pane. This manual seeks to teach you how to use 
commands on the menu bar and toolbar, and doesn’t always specify when you can use the shortcut 
menu. Once you become familiar with Ontrack PowerControls, the commands available to you on 
the shortcut menu should become apparent.

Notes and Tips

The notes and tips in this user guide follow the guidelines offered in the Microsoft Manual of Style 
for Technical Publications, 3rd Edition. Redmond, WA: Microsoft Press, 2004.
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CHAPTER 1

. . . . 
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
LOOKING AT THE INTERFACE CHAPTER 1 : 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Overview

This section describes the parts of the main Ontrack® PowerControls™ window for SharePoint, 
the function of each pane, menu, and toolbar, and shows you how to customize the window. 

It also describes on a high level how SharePoint content database files can be opened as one or 
more sources; how the source is displayed in a tree view and mimics the hierarchy in the 
SharePoint database; and how the source data for lists is displayed with customized column 
headings depending on the data type.

This section also describes on a high level how Ontrack PowerControls can connect to SharePoint 
content SQL databases as a target; how in using the Microsoft® SQL Server® content databases, 
Ontrack PowerControls can open one or more targets and display the target as a tree view 
mimicking the hierarchy in the SharePoint database; and how the target data for lists is displayed in 
the list pane with customized column headings depending on the data type.

For more information on using these functions, see “Using Ontrack PowerControls for SharePoint” 
on page 25.

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Ontrack PowerControls Main Window for SharePoint 

The Ontrack PowerControls main window for SharePoint is where you do most of your work. This 
window displays the source MDF, NDF, and LDF file(s) as well as the target server. The target acts 
as a container for the restored items. 

Any functions that can be performed on a source data item or target items can be accessed through 
the menu bar, the toolbar, or the right-click context menus.

The source panes contain the SharePoint content database tree view on the left side and when an 
item is selected, the contents are displayed in a list in the right pane.

The target panes contain any SharePoint nodes and contents copied, dragged and dropped, or added 
through the Data Wizard. The right pane displays the list of the contents of the item selected in the 
tree view.
Copyright © 2010 Kroll Ontrack Inc. 11
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Ontrack PowerControls Main Window for SharePointCHAPTER 1
Figure 1-1. The Ontrack PowerControls for SharePoint main window with four panes

Menu Bar

Figure 1-2. The Menu Bar in the main window

The menu bar contains all of the Ontrack PowerControls commands for SharePoint. The menu 
commands, submenu commands, and resulting windows are discussed fully in the sections that 
focus on those specific commands. 
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. .L O O K I N G  A T  T H E  I N T E R F A C E
Ontrack PowerControls Main Window for SharePoint
Toolbar

Figure 1-3. The Button Toolbar in the main window

The buttons on the toolbar perform the following functions:

Icons in Tree Views

In the source and target panes, the root nodes, sites, lists, and folders have individualized icons. 
Any list type without an assigned icon uses a default icon .

Note:  Not all lists for a site are shown in the list. If certain lists contain system information, they 
may not be shown.

Open Source displays the Source Path Selection page of the Data Wizard, where 
you can add .mdf, .ndf., and .ldf files.

Open Target displays the Target Server Selection page of the Data Wizard, where 
you can enter the SQL Server Name, configuration database, and authentication.

Copy copies onto the Clipboard the selected item(s) in the source list or list and 
folders from the tree view. 

Paste inserts the items from the Clipboard into the selected list or folder in the target 
pane. 

Export displays the Export Item window, which lets you export an item to a local or 
network drive destination. 

Find displays the Find in Sources window, which lets you specify the desired search 
criteria for finding items in the source pane.

View Help displays Ontrack PowerControls for SharePoint Online Help, which 
includes all of the information in this user guide and more. Online Help lets you 
quickly access this information by using a Contents, Search, or Index tab.

Kroll Ontrack on the Web takes you to the Kroll Ontrack web site 
(www.krollontrack.com), providing you with additional information on products and 
services by Kroll Ontrack.
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Ontrack PowerControls Main Window for SharePointCHAPTER 1
Figure 1-4. Sample icons with descriptions below 

Sources contains one or more source data stores. You can select the sources root 
node as your search source.

Targets contains the SQL Server databases for connection as a target.

Source Root Node contains the .mdf, .ndf, and .ldf files. Click the plus sign (+) next 
to a node to expand its contents.

Target Root Node contains the SharePoint SQL database. Click the plus sign (+) 
next to a node to expand its contents.

Site contains the site/site collection nodes lists. Click the plus sign (+) next to a node 
to expand its contents.

Default icon for List objects, custom lists, and Datasheet

Document Library, Form Library, Wiki Page Library are Web Parts that 
organize documents by department, project, or by topic.

Folders can be created within Web Parts to organize documents or lists.

Discussion Board can contain Web discussion notes between users of the site.

Agenda can contain information that meeting attendees need to have access to in 
advance of a meeting.

Calendar is a view of the events list after recurring events have been added.

Text Box can be created within a Web Part to just contain text.

Surveys can contain various forms of surveys: online surveys, email-based surveys, 
and database-driven surveys.
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Source Panes

The source list displays the SharePoint content database files that you selected in the Source Path 
Selection page of the Data Wizard. The source tree can display one or more sources. It displays the 
source as a tree view and mimicks the hierarchy of the SharePoint database.

Contacts, Attendees are lists that contain contacts for the users of the site including 
phone numbers, email addresses, and other information.

Picture Library, Report Library are Web Parts similar to Document Libraries 
which store documents and allow users to attach metadata to the documents.

Data Connection Libraries are Web Parts similar to Document Libraries which 
store documents and allow users to attach metadata to the documents.

Slide Libraries are Web Parts similar to Document Libraries which store documents 
and allow users to attach metadata to the documents.

Translation Library, Languages, and Translators are the list of languages to 
assign to translation tasks and any translators specified for each language.

Announcements is a Web Part in SharePoint and contains any announcements 
entered by a Site Administrator.

Links is a Lists Web Part that provides easy access to web sites.

Tasks is a Lists Web Part used for managing tasks within a project.

Project Tasks, Issue Tracking are used to track issues based on different categories 
added by the Site Administrator.

Decisions is a list created from a template within a Meeting Site in SharePoint.

Things to Bring contains lists in the Lists Web Part.

Datasheet is a view within a library or list that requires Microsoft Excel to open.

KPI List contains Key Performance Indicator lists in the Lists Web Part.
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Ontrack PowerControls Main Window for SharePointCHAPTER 1
Figure 1-5. The source tree view of a SharePoint database

For more information on using the source panes, see “Data Wizard: Source Path Selection” on 
page 26.

SOURCE ITEM LIST

The source item list displays the source items in a list with columns depending on the type of 
source list. The columns can include leaf name; attachments, if any; title; content type; UI Version; 
modified and created on dates; created by; and modified by. 

Figure 1-6. Source Data List

You can open a source data list item using the native application with which it was created by right-
clicking on the item and selecting Open File in the context menu. If the native application for the 
item is not available on your computer, a window is displayed to allow you to select the application 
to view the item data. If you want to view the metadata of an item that can be opened with the 
native application, right-click and select Open Item.

Source Data List Context Menu

Source list items have several functions available through a context menu. You can right-click on 
an item or multiple items to display a context menu with the following options available: 

• Open Item: Displays the metadata of an item in a new window or open the native 
application.

• Open File: Open File is available if the item has a content stream. Only one item can be 
selected at a time.
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. .L O O K I N G  A T  T H E  I N T E R F A C E
Ontrack PowerControls Main Window for SharePoint
• Copy: Copies the selected item or items to the clipboard.
• Select All: Selects all of the items in the list.
• Export: Displays the Export window and allows you to save the selected item to a selected 

location.
• Save Attachments: Displays the Save Attachment window and allows you to save the 

attachments of the selected item to a selected location.
• Previous Versions: Displays the Previous Versions window and allows you to view the 

previous versions of the item and copy them to a selected location or to the target pane.
Some context menu items are unavailable when multiple items are selected, i.e., “Open Item,” 
“Open File,” “Save Attachments,” and “Previous Version” functions.

For more information on all of these functions, see “Using Ontrack PowerControls for SharePoint” 
on page 25.

Target Panes

Ontrack PowerControls can connect to SharePoint SQL databases as a target. One or more targets 
can be opened at a time. The target data is displayed in a tree view which mimicks the hierarchy of 
the SharePoint database.

Figure 1-7. Target Tree View

TARGET ITEM LIST

The target item list displays the target items in a list with columns depending on the type of target 
list. The columns can include leaf name; attachments, if any; title; content type; UI Version; 
modified and created on dates; created by; and modified by.

Figure 1-8. Target Data List 
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You can open a target data list item using the native application with which it was created by right-
clicking on the item and selecting Open File in the context menu. If the native application for the 
item is not available on your computer, a window is displayed to allow you to select the application 
to view the item data. If you want to view the metadata of an item that can be opened with the 
native application, right-click and select Open Item. See “Opening Items” on page 30 for more 
information.

Figure 1-9. Open Item metadata

Note:  Not all the data about an item is displayed in the list. 

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
Changing the View

You can change the view in the Ontrack PowerControls window by hiding the toolbar or status bar, 
adjusting split bars; sorting lists; and refreshing the screen.
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Changing the View
Viewing or Hiding the Toolbar and Status Bar

The toolbar and status bar appear by default in the main window for Ontrack PowerControls for 
SharePoint, but you can easily hide them.

To hide the toolbar or status bar

• On the View menu, click Toolbar or Status Bar. The check mark no longer appears next to 
the name of the toolbar or status bar.

To view the toolbar or status bar

• On the View menu, click Toolbar or Status Bar. The check mark appears next to the name 
of the toolbar or status bar.

Resizing Panes Separated by a Split Bar

You can use a split bar (the horizontal or vertical double line that separates two panes) to increase 
the area within one pane while simultaneously decreasing the area within the adjacent pane. 

To resize panes separated by a split bar

1. Position the cursor over a split bar between the two panes until a double arrow  appears. 
A vertical double arrow  appears if you position the cursor over a horizontal split bar.

Figure 1-10. Resizing the split bar between the source and target list as well as the tree view 
pane from the list pane

2. Drag the split bar until the two panes are the desired size.
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